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The Roadway Safety Assessment Tool (RSAT) is an assessment tool for states to use to identify 
and evaluate the safety of rural routes that are utilized by motorcoaches. It utilizes inputs from 
transportation and EMS professionals to measure crash risk along a route, as well as the 
robustness of communications, EMS response capabilities, and proximity to hospitals and trauma 
centers. In essence RSAT is a collection of defined methodologies for ingesting, processing, 
analyzing, and mapping of data for the assessment of roadway safety for motorcoach travel. 
RSAT is based on a geographic information system (GIS) platform that utilizes ArcGIS for 
processing data and Google Earth for visualization. A working of knowledge of ArcGIS is 
necessary to perform additional processing and manipulation of the data while only a basic 
understanding of Google Earth is necessary to visualize the data. The details of installing and 
utilizing the two pieces are described in the following sections. 
 
Installation 
 RSAT is distributed in a single compressed (RSAT.zip) file folder containing the data and files 
to support processing and visualization of the data. Separate access is required to ArcGIS 
Desktop Basic Edition 10.2 with Spatial Analyst extension for processing and Google Earth 7.1 
is required for visualization. Google Earth can be downloaded here: 
http://www.google.com/earth/download/ge/agree.html. After unzipping the RSAT folder should 
be placed in the top level of the local hard disk (C:). 
 
Included Example Data and Safety Layers 
The RSAT folder contains a wealth of example data layers in point, line, and raster format on 
various infrastructure and safety data. The folder with the data should look similar to the 
following: 
 

    
 
'Base Layers' contains background ESRI Shapefiles for Lakes (Lakes_US), Neighboring 
Countries (neighcountry), Major Roadways (NHPN), Major Roadway Centroids 
(NHPN_Centroids), Scored Roadways (NHPN_Scored), and State Boundaries (States). 
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'KMZ Layers' contains Google Earth files in raster format for Air Medical Service Providers 
(AAMB), Communications (CELL), Aggregated Safety Scores (CUMLATIVE), Fatal Crashes 
2007-2011 (FARS), Ground Ambulance Depots (GAMB), and Locations of Level 1, 2, and 3 
Trauma Centers (TC). In addition a vector file is also provided for Scored Roadways (NHPN). 
 
'Point Layers' contains ESRI Shapefiles for Fatal Crashes 2007-2011 (FARS_07_11) obtained 
from http://www.nhtsa.gov/FARS. Other layers used in demonstrating RSAT can be obtained 
from their respective agencies or substituted with  user supplied data on: Air Medical Service 
Providers (AirAmbulance) obtained from http://www.adamsairmed.org/ , Communications 
(CellTowers)  and Ground Ambulance Depots (Ground Ambulance) obtained from 
https://www.hifldwg.org/, and Locations of Level 1, 2, and 3 Trauma Centers (TraumaCenters) 
obtained from http://www.amtrauma.org/?page=TIEP. 
 
'Raster Layers' contains ESRI files in raster format in two folders for UnClassed (raw distance 
data) and ReClassed (standardized distance data) for Air Medical Service Providers (AAMB), 
Communications (CELL), Aggregated Safety Scores (EQUALWEIGHT), Fatal Crashes 2007-
2011 (FARS), Ground Ambulance Depots (GAMB), Locations of Level 1 Trauma Centers 
(TC1), Locations of Level 1, and 2 Trauma Centers (TC12), and Locations of Level 1, 2, and 3 
Trauma Centers (TC123). 
 
As previously mentioned 'RSAT Processor.mxd' launches the processor application in ArcGIS.  
 
The sources of the data are as follows: 

• Lakes: ESRI 
• Neighboring Countries: ESRI 
• State Boundaries: ESRI   
• Major Roadways: Federal Highway Administration (FHWA) National Highway Planning 

Network (NHPN) 
• Air Medical Service Providers: CUBRC, Atlas and Database of Air Medical Service 

Providers (ADAMS) 
• Communications/Cell Tower Locations: National Geospatial Agency (NGA), Homeland 

Security Infrastructure Program (HSIP) 
• Ground Ambulance Depots: National Geospatial Agency (NGA), Homeland Security 

Infrastructure Program (HSIP) 
• Fatal Crashes 2007-2011: National Highway Traffic Safety Administration (NHTSA) 

Fatal Accident Reporting System (FARS) 
• Trauma Center Locations: American Trauma Society (ATS),Trauma Information 

Exchange Program (TIEP) 
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RSAT Processor1  
The RSAT processor was designed to be used with ArcGIS 10.2. After this software has been 
installed the RSAT Processor application can be opened to create, manage, and process 
infrastructure and safety data. To start the RSAT Processor open 'RSAT Processor.mxd' by 
double clicking on it. The start-up screen will look similar to below: 
 

 
 
The RSAT processor allows users to selectively browse the different data sets previously 
discussed as well as process and implement new data layers. Any data set that is considered 
relevant to the assessment of safe motor coach travel can be imported as an ESRI point shapefile. 
The Following example will demonstrate adding new data or working with existing data to create 
an overall safety raster layer and highway line file. 
 
Step 1: Add a new point layer 
Point based layers can be added for national, regional or the local level.  

 
 
 

                                                            
1 For users who wish to visualize the included data immediately skip ahead to RSAT Visualizer 
 



Step 2: Open the Spatial Analyst Extension to Create a Distance Raster 
This step will create a continuous raster image which measures the distance in a straight line to 
the nearest asset in the point layer that was previously added. Navigate to: 
ArcToolbox>Spatial Analyst>Euclidian Distance 
 

 
 
In the Euclidean Distance dialog box set the input as the layer of interest. Name a output raster 
file name and location, leave maximum distance blank, set output cell size to 1,609.34 (1 mile 
grid in meters), and output direction blank. 
 

 
 
Click on the 'Environments...' button and then expand Environment Setting>Processing Extent. 
Set Extent to 'Same as layer States'. This limits the analysis search and measurement functions to 
be contained within boundary of the US states. In 'Raster Analysis' set cell size to be 'As 
Specified Below' to 1609.34 (1 mile grid as measured in meters). Set 'Mask' to 
'BaseLayers\States' to show the output raster only within the confines of the US states boundary 
layer.  



 

 
 
Next select 'OK' for Environment Settings and the 'OK' for Euclidean Distance. The result should 
be a continuous value grid for the continental US. Analysis can be done with the resulting layer 
or it may be standardized for use with additional data. To standardize proceed with step 3. 



Step 3: Reclass the Data 
This step allows the user to create standardized values for the distribution of values that were 
computed in the previous step. The standardized values can then be added to other dissimilar 
layers that have also been standardized.  
 
ArcToolbox>Spatial Analyst>Reclass>Reclassify 

 
 
Set the parameters for the reclassification by selecting the input raster. Next set the reclass field 
to 'Value' and set the output raster to the desired location and name. 
 



 
 
Next click on 'Classify' and set the method to Natural Breaks (Jenks) and Classes to 5. 
Alternatively, a different statistical method can be used to classify the value such as equal 
breaks, equal interval or standard deviation as deemed appropriate by the analyst.  
 

 
 



Next select 'OK' for Classification and the 'OK' for Reclassify. The result should be a continuous 
value grid for the continental US similar to the raster created previously but with standardized 
grid values. 
 
Step 4: Sum and Weight all Raster layers for analysis 
After steps 1-3 are repeated for all layers of interest that can be combined to produce a similar 
cumulative score. In this method, weighting of individual layers can be used to adjust the relative 
importance of those assets to the overall calculated safety score. Navigate to:  
ArcToolbox>Spatial Analyst>Map Algebra>Raster Calculator 
 

 
 
Add together all layers of interest and give appropriate weights to each layer based on a 0-1 
scale. Note: proximity to beneficial layers should be weighted as positive values while proximity 
to detrimental layers i.e. fatal crashes should weighted as negative. The default value to set 
beneficial assets to is 1.0 and -1.0 for harmful assets). The analyst should provide appropriate 
values that are consistent with their understanding of available assets and distribution in the 
study area. 
 



 
 
Select 'OK' for Raster Calculator to generate the overall safety raster layer. 
 
Step 5: Extracting Point Values to Join to the Roadway Line Files 
This step will allow the user to  
ArcToolbox>Spatial Analyst>Extraction>Extract Values to Points 
 

 
 



 
 
Next, right click on the Major Roadways layer under Base Layers in the table of contents. Select 
Joins and Relates and then Join... 
 

 
 
 
 
 
 
 
 
 
 
 



In the Join dialog box under the 'What do you want to join to this layer?' Select Join data from 
another layer based on spatial location. In item number one select the name of the file that was 
created in 'Extract Values to Points' procedure. In item number two select the second radio 
button to give each line the attributes (score) of the nearest point. Due to the fact that that the 
roadways centroids were created from the roadway line segments there will be a one-to-one 
association with no ambiguity. For item three, select a name and location for the output file. 
 

 
 
The result of this step will be scored roadways for the continental US. They can be viewed or 
analyzed in ArcGIS to assess areas of at-risk travel due to the lack of available resources.  
 
Step 6: Converting Raster layers and Roadways to Google Earth Format 
In order to make this data more accessible to a wider audience that does have working 
knowledge of ArcGIS or spatial data handling procedures, one additional step will be taken to 
convert the data to Google Earth format. 



To convert the scored roadways layer to manageable size for viewing in Google Earth, navigate 
to: ArcToolbox>Data Management Tools>Generalization>Dissolve 
 

 
 
 
In the dissolve dialog box select the scored roadway file as the input feature. Set an output file 
name and destination. Set the dissolve field to the raster value field that was created for this layer 
in step 5 (RASTERVA_1 or other). Check multipart features to allow ArcGIS to create a single 
feature for each roadway with a common value. 
 



 
 
After clicking OK a file will be generated that groups all roadways of similar scores thus 
reducing the file from greater than 141,000 records to less than 20. This will ensure that the file 
can be viewed efficiently in Google Earth. 
 
Next, each file that the user intends to view in Google Earth can be exported from ESRI format 
to a compressed Google Earth format (KMZ). The first set is to save each data set as a layer file. 
Right click on each layer to export and select 'Save as Layer File...'. Select a file name and 
destination. 
 



 
 
Next, navigate to: ArcToolbox>Conversion Tools>To KML>Layer to KML 
 

 
 
In the Layer to KML dialog box select the layer to convert that was created in the previous step. 
Next select a file name and destination for the Google Earth KMZ file. Leave layer output scale 
to zero; check clamp feature to ground and leave the other extents set to the defaults. 
 



 
 
Click ok and repeat the steps for save as layer and layer to KML for each set of data the user 
intends to view in Google Earth. 
 
The processing of the data layers is now complete and the user can launch the RSAT Visualizer 
as described in the next section. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



RSAT Visualizer 
The RSAT Visualizer will allow users to explore the data layers included in the tool delivery as 
well as any new layers created by the analyst in ArcGIS. After downloading Google Earth from 
the link provided at the beginning of this document, follow the instructions provided by Google 
to install the software. Upon starting Google Earth you should be greeted with a similar screen as 
that below: 
 

 
 
Upon using the RSAT data for the first time each layer will need to be opened in Google Earth 
and moved to the 'My Places' section for viewing at a later date. To open each of the KMZ layers 
included with the tool or additional layers created in ArcGIS open the File Menu and select 
Open. Navigate to the folder where the KMZ files are stored (the included RSAT layers are in 
RSAT>KMZ Layers). Repeat to open each layer intended to be viewed. 
 

 



Google Earth will drape the image over the background globe resulting in the following: 
 

  
 
In order to have the images load upon opening of Google Earth in the future they need to be 
moved to 'My Places'. To move each layer drag and drop them from 'Temporary Places' to 'My 
Places'. After all layers have been added and moved it should look similar to the following: 
 

 
 
To change the transparency of raster files and style of markers, lines, or fills on vector files right-
click on the layer and select Properties. 
 



  
 

The Edit Image Overlay dialog box allows the user to adjust the transparency of the layer or 
adjust its spatial attributes (See Google Earth for Documentation). The Edit Placemark dialog 
box allows users to change the styles of markers, outlines and fills as well as adjust spatial 
attributes. 

  

 



All of the layers should now be ready to view in the Google Earth. Additional Features and 
layers are also available in Google Earth to perform additional analysis such as overlaying 
routes, traffic, places, and pictures. For additional information on the features of Google Earth 
please access the following: 
https://support.google.com/earth/answer/176145?hl=en&ref_topic=4363013 
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